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 QuickShadows for TS12

This is an amended version of an article originally written 
for John King's Trainz Resources Newsletter.  

Introduction

The  QuickShadows  tool  is  provided  to  the  Trainz 
community for the generation of shadow meshes without 
having to use 3DSMax, Gmax or Blender.  

Many  rolling  stock  items  downloaded  into  TS2009  and 
later show errors caused by missing shadow meshes, and 
now TS12 has a runtime device that checks the polygon 
count  of  shadow meshes. If  a shadow mesh has more 
than about 1300 polygons it is ignored and a crude box is 
substituted, much to the annoyance of many users.

The original  QuickShadows was conceived to provide a 
box shadow or a full black-only copy of the original mesh. 
With this limitation set by TS12 it seemed appropriate to 
try to provide a method to build a simple shadow mesh 
that  could  still  be  a  reasonable  representation  of  the 
shape of the parent object, in most cases some piece of 
rolling stock.  Some method for maintaining some detail, 
yet  utilising  a  reasonable  degree  of  polygon  reduction 
needed to be found. 

The new process in QuickShadows looks at every triangle 
outline (its lines) and establishes a profile on a grid, and 
then applies a poly reduction technique to the result.  This 
process is repeated for a number of planes (up to 6) to 
create  an  inside-out  shadow  mesh;  meaning  the  side 
nearest  the  cast  shadow  does  most  of  the  work.   A 
completely  different  approach  to  the  normal  shadow 
construction.  The shadows made with this method have 
no top plane (or roof) . 

Shadow meshes for average sized locos and wagons with 
reasonable  detail  can  be  made  with  less  than  1000 
polygons. 

The  above  method  makes  the  new  “Simple  Shadow 
Mesh”.  The  original  “Box  Shadow”  and  “Full  Shadow” 
options are still  provided.   If  used with  AssetX a fourth 
option of an invisible shadow mesh is also available.

For  all  its  options,  QuickShadows.exe  creates  a 

temp.XML file which is then converted to IM by Auran's 
TrainzMeshImporter  program.  Auran's  policy  of  having 
their  own  software  make  all  game  content  is  thus 
maintained.  The TMI is included in the installer program.

The shadow mesh (“shadow.im” or any other name set by 
the user) is created in the same folder as the parent mesh 
and requires no textures.  It uses the "m.notex" material 
that takes its colour from the light settings in the material. 
The “m.notex” material is made two sided by default so 
that all planes of the “Simple Shadow” mesh are always 
visible  when viewed with my Trainz Mesh Viewer tool.

No  3D  modelling  or  image  manipulation  programs  are 
required to make the shadow.  The shadow mesh may be 
moved within the asset folder structure (eg to a shadow 
folder) and, of course, the shadow mesh will need to be 
specified in the shadow container in the mesh table of the 
config.txt  file.  Refer to the Content Creators'  Guide for 
Trainz Classics for advice on asset folder and file layouts. 
CCGTC can be downloaded from the Auran web site.

Using the QuickShadows Program

Installation

If  you  don't  have  this  program,  please  download  its 
installer  program  (PEV_QuickShadows_setup.exe)  from 
my PEVSoft Download page.

http://www.members.optusnet.com.au/~villaump/pevsoft.htm

Run the installer and the QuickShadows will be loaded on 
to the Program Files area of your C: drive, along with a 
desktop icon and an entry in the PEVSoft folder of your All 
Programs menu.

TrainzMeshImporter.exe is included in the setup program. 
It  may require  a  further  download  from MicroSoft  (See 
below)

If  you  have  TS2009 or  later,  QuickShadows  will  create 
'OpenWith' macros for Content Manager 2 and 3 to allow 
you  to  run  QuickShadows  directly  from  the  Content 
Manager for each Trainz version
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On first  launching  QuickShadows  it  will  check  that  the 
OpenWith macros for the Content Managers have been 
set up.  The program generates these automatically if  it 
finds  TS2009,  TS2010  and/or  TS12  installations  in  the 
default locations.  Once done this process is not repeated, 
until the user selects Open With from Setup in the main 
menu.

If you choose Open With, the program scans your PC for 
Trainz installations.  If it finds any in the default locations, 
the OpenWith macros are automatically installed.

If a default installation is not found, the program presents 
you with a Find Folder dialog.  If  you do NOT have the 
Trainz version requested then press the Cancel  button. 
Otherwise  locate  the  TS2009  or  TS2010  or  TS12 
application  folder  as  requested  and  select  it.   The 
OpenWith  macro  will  be  automatically  placed  into  the 
selected Trainz installation.

Opening a File

The program can open .pm and .im files only. 

To Open a File, start the program and click on the File 
menu. Click on Open and the open file dialogue box will 
be displayed. The file extensions are filtered so only the 
correct types can be opened.

When  a  file  is  opened  the  program  shows  a  notice 
suggesting  you  press  the  Make  Shadow  button  to 
proceed.

Before doing so you need to select a shadow type from 
the Action List at the top right of the program window. 

To make a shadow press the Make Shadow button.

The Exit option closes the program.

Making a Box Shadow

When opened from a short cut, the program will await a 
file open instruction from the user.

Click on the File menu. Click on Open and the open file 
dialogue  box  will  be  displayed.  The  file  extensions  are 
filtered so only PM's or IM's will be visible. Select a mesh 
to make a shadow for.

The program will  confirm your mesh choice and show a 
notice suggesting you press the Make Shadow button to 
proceed.

If the "Box Shadow" option is selected from the Action List 
then the program will  make a box shadow mesh. (as in 
the figure to the left)

For  a  shadow  mesh  to  be  successful  it  needs  to  not 
protrude through the skin of the parent (or default) mesh. 
For  the  box  mesh,  independent  scaling  factors  are 
provided  for  length,  width  and  height.  Because  the 
shadow mesh box size is created from a bounding box for 
the parent mesh it is highly likely that the mesh will be too 
large.  Use  the  scaling  factors  to  reduce  the  size.  A 
Scaling factor of 1.0 is full size.. Use decimal fractions (eg 
0.8) to reduce size.
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A hidden scale factor is included so that the shadow of a 
rectangular object is slightly smaller than the object, This 
is  intended  to  prevent  any  rendering  conflicts  that  can 
cause the dreaded phasing effect in the game. 

Press the "Make Shadow"  button and shadow.im mesh 
will be created. When completed the program will tell you 
that the shadow.im file has been created.

If  the shadow mesh is offset from the main mesh when 
you view it in Trainz, the box shadow can be moved using 
the X, Y, and Z Displacement values. These values are in 
metres.

For example, if the shadow is too low, you can move it up 
by entering a positive value into the Z Displacement box. 
This  is  common  where  the  parent  mesh  has  a  small 
portion that is higher than the remainder of the mesh, eg a 
post.  Note that this feature is only available for the box 
shadow.

The  "Zero  All"  button  can  be  used  to  make  all 
displacements zero.   Note:  the displacements default  to 
zero when ever the program is opened. These values are 
not stored for later use.

Files opened by double clicking in Windows Explorer can 
automatically have a shadow mesh created if  the "Auto 
Make" option is SET (checked).  The program will  close 
automatically after a short pause if the "Close on Done" 
option is SET.

The shadow mesh is created in the same folder as the 
parent mesh. It does not require any textures.

Making a Simple Shadow  ** NEW for TS12 **

When opened from a short cut, the program will await a 
file open instruction from the user. Click on the  File menu. 
Click  on  Open  and  the  open  file  dialogue  box  will  be 
displayed.  The file extensions are filtered so only PM's or 
IM's will be visible. Select a mesh to make a shadow for.

The program will  confirm your mesh choice and show a 
notice suggesting you press the Make Shadow button to 
proceed.

Choose the Simple Shadow option from the Action List at 
the top right of the program window.

The simple shadow can consist of up to six (6) shaped 
planes.  

An Example

Let us now make a shadow using Paul Hobb's excellent 
LNER Gresley A3 steam loco as an example.

From  the  file  open  dialogue  select  the  mesh  with  the 
highest level of detail and open it.  It doesn't matter if the 
parent  mesh  has  a  huge  number  of  polygons. 
QuickShadows  creates  a  fixed  number  of  polygons  for 
each plane it generates and then does poly reduction on 
that plane as it is drawn.

Turn off all the plane “Use” options and press the “Make 
Shadow” button.
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The floor plane and longitudinal centre line plane form the 
backbone of the shadow, as shown.

Note that  in this example the floor plane offset  is 1.6m 
above  the  lowest  extremity  and  no  front,  back  or  side 
planes are used.

If  we now enable the front plane we can move it to the 
correct location.   Press the Make Shadow button again 
and the mesh will be rebuilt.

Here  we  have  the  front  plane  with  zero  offset;  just 
showing  the  buffers  and  coupling  or  hose.   Now  we 
change the Front Plane Offset to 1.65m, and make the 
shadow again.

The two  views  above show the front  plane  now in  the 
shape of  the  front  of  the  boiler  located  just  where  the 
boiler shape commences. With the sun behind the loco it 
will now cast a shadow of the boiler correctly.

Now we enable the Back Plane with zero offset and make 
the shadow again.

Here we have the shape of the back of the cab and cab 
steps at the back extremity.

To get closer to the true shadow shape we also need to 
enable the Side Planes and re-make the shadow.

The shadow cast to the side to the loco will now show the 
cab correctly. 

In the Mesh Viewer  rotate the shadow mesh around to 
ensure that there are no gaps between the planes.  In this 
case we will have a gap at the rear of the cab as below.

Adjust  the  Back  Plane offset  to  0.4m and re-make the 
shadow.

It is advisable to have a small offset of say 0.05m for the 
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Side Planes. This ensures that any gaps caused by the 
point sampling method are closed up. 

Scaling factors are provided to adjust the overall size of 
simple shadow meshes. It is recommended that the width 
and height scales be less than 1.00 ( I used 0.95 in the 
example  above)  to  prevent  any  rendering  conflicts  that 
can cause the dreaded phasing effect in the game.  In 
most cases it is better to leave the length scaling at 1.00.

These  scaling  factors  are  different  from  those  for  box 
shadows and are stored for later use. 

This  completes  the  shadow mesh for  Paul's  A3.   Poly 
count is 659 in this case.

The checking of the progress of your mesh build can be 
done  if  you  connect  Trainz  Mesh  Viewer  to 
QuickShadows. (see Setup section later).  If you have set 
up the mesh viewer to check the shadow it will be opened 
immediately  on  completion  provided  that  the  Close  On 
Done option is NOT set. 

Another Example

Now let  us build  a  shadow mesh for  a  regular  shaped 
passenger car.  I have chosen the BR MK1 Crimson and 
Creams for this example.

Again we start with plane options all off and we get the 
following.

Because the car is symmetrical we can turn on the Font 
and Back planes together.

In  this  case  the  cars  have  bellows  passageways 
connecting them, so the roof of the car commences about 
0.4m  from  the  ends.   Set  the  Front  and  Back  Plane 
Offsets to 0.4m.

The  Side  planes  can  now be  enabled  (again  with  the 
0.05m offset)

The BR MK1 shadow mesh is complete.. poly count 480.

Footnote: The MK1 cars have roof ventilators that put little 
bumps in the top of the profile.  This raises the poly count,
as shown below:

©  Peter Villaume  (PEV)  2011                                                                                                                                          5



The longitudinal centreline plane is the lengthways profile 
of the entire parent object.  If you enable the “Use Profile 
as Sides” option, the centreline profile plane will be placed 
along  each  side  of  the  shadow and removed from the 
centreline.   This  option  is  good  for  making  bogey 
shadows. 

Altering the Side Planes Offset will adjust the location of 
these profile  planes.  (it  will  not  affect  the shape in  this 
case)

The Show Images option in the Help menu turns on the 
display  of  images  to  illustrate  the  dimensions  that  are 
adjustable when offsets are altered. 

 

Move the mouse over  a box to see the image for that 
adjustment. 

Files opened by double clicking in Windows Explorer can 
automatically  have a  shadow mesh created if  the  Auto 
Make  option  is  checked.   The  program  will  close 
automatically  after  a  short  pause if  the  Close on Done 
option is checked.

The shadow mesh is created in the same folder as the 
parent mesh.  It does not require any textures.

Making a Full Shadow

As  in  the  previous  shadow  options,  after  opening  the 
program will confirm your mesh choice and show a notice 
suggesting  you  press  the  “Make  Shadow”  button  to 
proceed.

Choose “Full Shadow” from the Action List in the top right 
of the QuickShadows window. 

On pressing the “Make Shadow” button a Shadow mesh 
will be created using the geometry of the parent mesh, but 
with all animation and texture details stripped out.

When  completed  the  program  will  tell  you  that  the 
shadow.im file has been created.

The full shadow mesh is created in the same folder as the 
parent mesh. It does not require any textures.

It's  up  to  the  user  to  place  the  shadow  mesh  in  an 
appropriate folder and make any changes needed in the 
config.txt file.

Trawling.

Trawling  is  the process where  the program searches a 
folder and ALL of its sub folders for mesh files that require 
a shadow mesh to be appended. It is similar to the search 
function in Windows explorer, except that when it finds a 
mesh file it processes it without asking any questions.

I added the trawling facility to QuickShadows to assist the 
team doing asset repairs for TS2009/10.  There are many 
old rollingstock assets that don't have shadows and thus 
show an error in Content Manager 2 or 3
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So if  you have faulty content caused by the absence of 
shadow meshes (as flagged by the CM) you can use the 
CM  search  filter  for  faulty  content  and  open  it  all  for 
editing,  then  apply  the  trawling  process  to  the  editing 
folder.

To use Trawling you must launch this program from the 
command line with the -trawl switch, or launch from the 
Open With menu (right click) in Content Manager 2 or 3
If  you include the -close switch as well  the program will 
close immediately the TMI has finished building the mesh.

Select one or more items in Content Manager, then right 
click to bring up the menu.  Select Open With, then click 
on QuickShadows.bat.

The  selected  items  will  opened  for  edit  and  a  shadow 
added for every PM, and optionally every IM, found in the 
search.  Please be aware that only one shadow mesh per 
folder is created.  If a folder contains a number of meshes, 
only  one  shadow  will  be  remain  at  the  completion  of 
processing that folder.

When trawling you can stop the process at any time by 
pressing the "Stop Trawling" button.

The files processed are listed in the main text box as the 
conversions progress.

The program keeps a log (named Trawl_Log.txt)  of files 
found and shows the actions taken on each file. The log is 
accessed from the File menu and clicking on View Log. 
The log file accumulates data every time trawl is started. 
The Log should be deleted after large trawl conversions. 
A delete option is included in the File Menu.

Launching from the Command Line

The program can be launched from the command line to 
automatically make a shadow mesh based on a .PM or 
.IM mesh. 

If the command line parameter is a mesh file the program 
will automatically open that mesh and use its dimensions 
to build the shadow mesh.

If the command line parameter is a folder the program will 
open in that folder a wait for the user to select a mesh to 
process to make a shadow. Use the File Open menu to 
select a mesh.

However because the shadow is a bit hit or miss, I think 
it's better to run the program from a shortcut and look at 
the result as you go along.  You will  most probably find 
that you have to displace the mesh to get the best result, 
and this cannot be done from the command line.

Program Options

The following options are provided to customise how the 
program works.

Auto Make
To make the  program add shadows  to  PMs (and  IMs) 
when started from the command line, set the Auto Make 
Option.  The  option  will  be  ticked  (checked)  when  set. 
This option has no influence on trawling. 

Close on Done
The  program  will  close  on  completion  of  the  shadow 
making tasks if the Close on Done Option is set. 

Trawl for IMs
Setting  this  option  will  make  the  program  add  shadow 
meshes to IM files as well as PM files, when trawling.

Shadow Name
Clicking on this option opens a dialogue window that allow 
you to nominate a new name for your shadow meshes.  

Note: the name has no file extension.(.im) This is added by 
the TrainzMeshImporter as part of the XML file conversion.

All meshes made after changing the name will  have the 
new name.

Setup

The Setup menu offers selections to set up the OpenWith 
macros  in  Content  Managers  and  to  connect  a  Mesh 
Viewer program to QuickShadows to look at the shadow 
meshes produced so any adjustments can be made.

Open With
As  already  mentioned,  if  you  choose  Open  With,  the 
program scans your PC for Trainz installations.  If it finds 
any in  the  default  locations,  the  OpenWith macros  are 
automatically installed.

If a default installation is not found, the program presents 
you with a Find Folder dialogue.  If you do NOT have the 
Trainz version requested then press the Cancel  button. 
Otherwise  locate  the  TS2009  or  TS2010  or  TS12 
application  folder  as  requested  and  select  it.   The 
OpenWith  macro  will  be  automatically  placed  into  the 
selected Trainz installation.

Mesh Viewer
QuickShadows can optionally call a Mesh Viewer so you 
can  look  at  the  shadow  mesh  generated  to  make 
immediate adjustments to the mesh.  To enable the Mesh 
Viewer,  select  Mesh Viewer  from the  Setup  menu and 
answer  “Yes”  to  the  “Do  you  wish  to  locate  a  Mesh 
Viewer...” question.

A File Finder dialogue is then presented to you  Locate 
your  choice  of  Mesh Viewer  program and  click  on  the 
“Open” button.  The program location is saved for future 
use.  To have NO mesh viewer press the “Cancel” button.

©  Peter Villaume  (PEV)  2011                                                                                                                                          7



 
TrainzMeshImporter

The  QuickShadows  program  will  not  operate  if  the 
TrainzMeshImporter.exe is not in the QuickShadows.exe 
application folder. A notice to this effect is displayed for a 
few seconds before the program closes.

Also,  TrainzMeshImporter  requires  some Microsoft  C++ 
2005 SP1 runtime files, and if these are not present the 
TMI will not run, or may freeze.

Refer  to  the  program  help  if  the  TMI  is  not  working 
correctly.  A link to MicroSoft is provided in the help for 
downloading the runtime files.

INI File Options

The following  extra  options are available  by editing the 
entries  in  the  [Options]  or  [Simple]  sections  of  the 
“QuickShadows.ini” file.

DeleteXML=1 makes the program delete the temp.xml file 
when the TMI closes.  Change the 1 to 0 (zero) to retain 
the temp.xml file if you wish to inspect it.

DoubleSided=1 makes  the  “m.notex”  material  of  the 
shadow mesh two  sided,  so the planes  of  the  shadow 
mesh  can  be  viewed  from  any  angle  in  Trainz  Mesh 
Viewer.    Set  this  value to  zero  to see the true nature 
shadow mesh.  Note that regardless of the DoubleSided 
setting, the planes of the mesh only cast a shadow from 
one side. (with the exception of the centreline plane of the 
Simple Shadow which is drawn twice so that it is opaque 
from both sides)

MakeWhite=0 makes  the  mesh  ambient  and  diffuse 
lighting colour values mid grey.  If the value is set to 1 the 
two  colours  are  made  white.   This  helps  to  make  the 
different  planes  of  the  mesh  distinguishable  from  one 
another when viewed in Trainz Mesh Viewer.  

XIncrement=0.1000  (a  value  in  metres)  in  the [Simple] 
section,  is  the  size  of  the  grid  to  which  the  X 
measurements  (across  the  object)  are  clamped.   The 
smaller  the  value  the  higher  the  polygon  count  in  the 
finished Simple Mesh.

YIncrement=0.1000  (a  value  in  metres)  in  the [Simple] 
section,  is  the  size  of  the  grid  to  which  the  Y 
measurements  (along  the  length  of  the  object)  are 
clamped.  The smaller the value the higher the polygon 
count  in  the  finished  Simple  Mesh.  (0.1000  metres  is 
roughly 4 ins)

File=English.txt in the [Language] section of the INI file, 
controls the language of the text strings in the program.  If 
you  change the file name to “Deutsch.txt”,  the included 
German file will be used for the text.  A new language file 
can be created from the English.txt file by translating it as 
directed in the file. 

Disclaimer

PEV can accept no liability what so ever for any loss or 
damage  to  any  data  or  hardware  through  the  use  or 
misuse of QuickShadows.

The program is provided free of charge and in good faith 
to assist the Trainz User Community.

The  QuickShadows  program  cannot  produce  perfect 
shadows. It is a content creator's responsibility to provide 
appropriate  shadow  meshes  to  suit  the  target  Trainz 
versions.

QuickShadows is offered as a way to repair content that is 
deemed faulty by the game or to provide a shadow  for an 
asset where the shadow mesh is missing.
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